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IntroductionChapter 1 

What is energyXT?
EnergyXT is an integrated powerful music production environment. A one-stop solution for making music 
so to speak. Whether you are a song writer who wants to record "hand-made" music, a producer who wants 
to tap the full potential of a software-based production environment, a sound designer who wants to shape 
sound, or a podcaster who is looking for a solution to simply cut his casts: energyXT is for you.

EnergyXT comes with all components of a professional recording studio such as a modular mixer, versatile 
EQs, a MIDI sequencer and the potential to use an unlimited number of commercially and freely available 
VST instruments and effects — all powered by a pristine and streamlined audio engine. It even brings along 
its own integrated sound sampler and synthesizer. Record audio, incorporate external sound modules, play 
top-notch software synthesizers and create mixes in a mixer environment, where nearly every parameter can 
be automated. There's much more to discover in energyXT. Find out for yourself by reading this manual.

Main features at a glance
EnergyXT has unique advantages over other music production suites making your work much easier and 
more efficient.

First of all it's organized in views rather than in window layers. MIDI and audio events can be edited right 
within their residing tracks. In fact every parameter and function can be controlled in one of the three main 
views without having to switch between different windows.

EnergyXT supports drag & drop transfers of VST instruments, effects and audio files and makes setting up 
a new production environment just a matter of a few minutes. 

Each component of energyXT is part of a modular environment where instruments and mixer channels 
can be freely connected to each other. This opens up a variety of applications in which some sequencers 
simply fail. 

Best of all, you can take energyXT with you anywhere you want to. Just copy the application files to a USB 
flash drive and you're ready to make music within a minute on every computer without having to undergo 
lengthy installation and configuration procedures. 

The Sequencer

The Sequencer is the heart of energyXT. That's where the music is being composed. The Sequencer supports 
MIDI and audio tracks for recording plus additional folder tracks for grouping. Events are clearly organized 
in Parts which can be freely distributed in a classic timeline view. Every Part features a powerful integrated 
piano roll editor for editing notes and controller events such as Modwheel or Pitch Bend. To avoid a high 
CPU load, tracks can be frozen to temporarily free up resources. Modern hooks and lines can be simply 
created with the multi-mode Arpeggiator and the Swing / Shuffle control, whereas rhythms can be easily 
imported as REX2-slices or WAV / AIFF files for a fast production process. The playback options for audio 
include high-quality timestretching, pitched and reverse playback.

The Drum Track

The Drum Track of energyXT is a special audio track with a built-in drum sampler and a powerful drum 
machine-like editor for easy rhythm creation. Trigger notes are created by placing note events in a grid which 
also grants direct access to volume, pan and filter cutoff parameters. Samples are organized in sampler cells 
and can be saved as a drumset preset for later use.
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The Mixer

The Mixer is the control center of energyXT. It houses all audio signals as separate channels which can be 
added dynamically. Parameters can either be automated from the Sequencer or controlled remotely from 
an external MIDI controller. With an unlimited number of possible VST effects, both insert and send, 4-band 
channel EQs and additional submix groups, mixing is as comfortable as it gets.

The Modular environment

The Modular environment is the core of energyXT and all its components. It serves as a multi-functional 
patchbay where each synthesizer, audio input / output, audio channel and effect can be freely routed. This 
opens up some exceptional application scenarios which can be realized with energyXT.

The Synth / Sampler

The built-in Synth is a complex phase modulation synthesizer and sampler for creating complex sound lay-
ers. With 4 LFOs powered by a complex modulation matrix, a versatile multi-mode filter, 6 envelopes and 
phaser, chorus, flanger, delay and reverb effects it meets all requirements you'd expect from an all-in-one 
sound workstation.

The Browser

The built-in Browser grants quick access to all energyXT relevant sound samples, instruments, effects and 
presets and supports drag & drop functionality. With the quick search bar even large amounts of sound 
samples can be browsed within seconds.

About the manual
For easy understanding, all sections are supported by multiple screenshots. This concept helps you to get 
to know the software and its possibilities in a fast and easy way.

On the last pages you can find a glossary which contains a brief description of important terms used 
throughout the manual. Refer to these explanations for background information on selected terms.

Which aspects of the software are covered?
This manual covers all important aspects of music production with energyXT. From MIDI to audio recording 
and editing you will find all the information you require to get the most out of the software quickly. The 
chapters are specifically tailored to different user groups and tasks. It should be easy to find at least one of 
these topic-related chapters useful for your work.

However there is still a lot more to discover within energyXT. Find out for yourself once you know the basics.  
Don't miss the online tutorials and the community support at www.energy-xt.com.

Conventions used in the manual

Menu functions and energyXT terms

Functions that can be reached via menus are described as follows:

File◊	  > Open

The first entry identifies the menu name. It is followed by one or more sub entries which name the menu 
function. Entries are separated with the ">" symbol.

For many functions you can also use the context menu (right-click).œœ

EnergyXT related terms are printed as they appear in the application, which is most often in Sentence 
case.

http://www.energy-xt.com
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File and folder names

File and folder names are put in quotation marks:

"energyXT2.exe"◊	

Shortcuts

Keyboard shortcuts can be used to trigger various functions of energyXT. They are displayed as follows:

Ctrl◊	  + S

A key combination is separated by a "+". Press the keys simultaneously to trigger the function.

Shortcuts mentioned in this manual refer to the default keyboard shortcut scheme.œœ

Screenshots

In the manual all screenshots has been taken from the Light skin of energyXT. For more information on how 
to change the skin of your application, see chapter Setting the look of the user interface.

User groups

Each application chapter begins with a list of target user groups. Use the list below to identify the user 
group profile that matches your interests. With this classification it should be easy to find the chapter(s) 
that are of interest to you.

The target groups covered in this manual are :

Podcaster:◊	  cuts and fades audio snippets and prepares multiple tracks for mixdown.

Sound Designer: ◊	 cuts samples and creates new sounds by using VST effects, time stretching algorithms 
and sound layering.

Mastering Engineer: ◊	 cuts and creates mixdowns by using equalizers and shapes the dynamic level 
of signals by using VST effects.

MIDI-Producer: ◊	 records MIDI data and makes use of VST instruments and internal drum pattern 
creation.

Songwriter: ◊	 records instruments with simultaneous playback of previously recorded tracks and uses 
input signal processing with VST effects.

DJ: ◊	 re-organizes audio snippets and uses VST effects with remote control for live application.

Guitarist / Keyboardist: ◊	 uses VST effects for signal processing instead of outboard equipment.

Terminology

In the manual the term energyXT is used to describe both the full version energyXT2.5 and the light version 
energyXT2.5 Compact. Differences between these two versions are stated, if necessary. For details, refer to 
the table on the previous page.

Comparison between energyXT2.5 and energyXT2.5 Compact
EnergyXT2.5 is the full featured software suite. It is sold separately as a boxed version or can be downloaded 
from www.energy-xt.com.

EnergyXT2.5 Compact is the light version of energyXT2.5 with selected functionality (see table on page 6). 
It is sold with selected hardware (e.g. BEHRINGER). EnergyXT2.5 Compact users can explore all functions of 
the full version at any time by entering a special Demo mode (see page Basic functions).

http://www.energy-xt.com
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Entering Demo mode in energyXT2.5 Compact
EnergyXT2.5 Compact users can explore all functions of the full version by entering a restricted Demo mode. 
In Demo mode, you can test the full potential of the software, but you can't save a Project.

As soon as you are about to use an exclusive energyXT2.5 feature you'll receive a notification.

Click on

Try ◊	 to enter Demo mode and test the function. 

Cancel◊	  to abort and go back to energyXT2.5 
Compact mode.

Remember to always save your projects œœ
before entering Demo mode to prevent 
data loss.

Upgrading energyXT2.5 Compact to energyXT2.5
Registered energyXT2.5 Compact users may upgrade to the full version of energyXT2.5 at www.energy-xt.
com or by using the menu XT > Upgrade now ....
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Chapter 2  Setup
EnergyXT has a unique feature that separates it from many other music production software — It can be 
used as a portable application which can be launched from removable devices like USB flash drives. This 
gives you the opportunity to take your whole setup with you and make music on different computers. Of 
course, you can also conventionally install the software on a single computer.

Portable (All OSes)
To launch energyXT without installation, you simply have to copy the complete energyXT folder to a 
target device (e.g. USB flash drives, hard disks) you wish the application to run from and execute the file 
"energyXT2". See chapter "Using energyXT on multiple systems" for details on how to use energyXT on 
different computers.

Installation

Windows / Mac OS / Linux

To install energyXT:

Visit the online tutorial at i.	 www.energy-xt.com or refer to the Quick Start Guide for details on how to 
install energyXT on your operating system. 

Activating your copy of energyXT
As soon as you launch energyXT for the first time, you will 
be prompted to enter your name and the serial number that 
came with your software. Provide the requested information 
to activate the software.

If you choose not to enter the requested data, œœ
energyXT will run in Demo mode. You can enter 
your serial number when launching the program 
at any time.

Right after activation you will be prompted to register your product. Registration enables you to always 
receive the latest updates and news.

The registration process requires an active internet connection.œœ

Software and hardware setup

Setting up your audio interface and hardware MIDI controllers
Before you can start to make music you first have to configure the software, to ensure that your hardware 
works properly with energyXT. The list below notes required hardware for different applications.

If you

are using external MIDI hardware, such as synthesizers, drum machines or samplers, you need at least ◊	
a MIDI interface.

are using VST software instruments you need at least a MIDI input device, such as a remote control or ◊	
a keyboard and an audio interface.

http://www.energy-xt.com
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record and play back audio you need an audio interface.◊	

EnergyXT supports audio interfaces with DirectSound (DS) / ASIO on Windows, Core Audio on Mac OS X 
and ALSA on Linux operating systems. 

If you want to work with VST instruments or record audio, it is strongly recommended that you œœ
use a professional audio interface to ensure low latency audio.

Connect and install all hardware before you enter the Setup of energyXT.œœ

Setting up your audio interface

To set up your audio interface:

Go to i.	 File > Setup > Audio.

Under ii.	 Device, choose the appropriate driver type for 
your audio interface.
EnergyXT automatically detects your audio interface and 
chooses the best driver type.

Identify your hardware in the subsequent field.iii.	

Under iv.	 Buffer size, choose an adequate latency setting. 

As a rule of thumb a low latency setting implies bet-œœ
ter audio performance, but the best setting for your 
system depends on your hardware. If you experience 
audio dropouts, try higher values. A reasonable 
entry to start with would be 1024 samples.

Under v.	 Sample rate and Record, choose the recording 
and playback settings.

If possible, choose 24-bits for high-quality recordings.œœ

Check the inputs and outputs of your audio interface you want to use under vi.	 Audio inputs and Audio 
outputs.

Make sure that at least one pair of inputs and outputs is active.œœ

Setting up your MIDI hardware

To set up your MIDI hardware:

Go to i.	 File > Setup > MIDI.

Check your MIDI hardware under ii.	 MIDI inputs and MIDI 
outputs.

Remember to connect and activate both inputs and œœ
outputs for devices which rely on a MIDI data loop to 
work properly (e.g. motorized fader remote control, 
keyboard with a tone generator).
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Setting folder paths
EnergyXT offers a file browser which grants quick access to plug-ins, presets, projects and samples. To use 
the Browser effectively, you have to set the necessary folder paths first.

To set the folder paths for the Browser:

Go to i.	 File > Setup > Browser.

Select the entry for which you want to set the folder path.ii.	

Click on iii.	 Add to add an entry to the list.

In the browser window, navigate to the folder which iv.	
contains the respective files and confirm by clicking 
on OK.

You can add multiple folder paths to each cat-œœ
egory.

Repeat steps ii.-iv. to include all folders that contain v.	
relevant files.

Setting the look of the user interface
The user interface of energyXT can be set to either dark or 
light colors, according to your preference.

EnergyXT2.5 users can download additional skins from  
www.xt-user.com.

To set the look of the user interface:

Go to i.	 File > Setup > Looks.

Click on the respective entry to set the user interface to either ii.	 Light or Dark colors.
Alternatively, click on Open to apply a downloaded skin.

You may also customize the look of your interface. Use the browser to change the look of all ele-œœ
ments within the application manually

http://www.xt-user.com
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The BasicsChapter 3 

Target user: All users

Structure of energyXT
The main window

Before you can start making music you have to learn the basics of energyXT first. The basic structure of 
energyXT is simple but effective. The main window is divided into three areas.

The menu bar and global control area1	

The menu bar shows the options available for each of the three views (Modular, Sequencer, Mixer). Below you 
see from left to right the Recent Projects drop-down list, the MIDI input meter with the controller mapping 
options, the metronome icon, the tempo designation for the Project, the transport controls, the mixdown 
icon and the song position timer. The text to the bottom right (actually Arpeggiator Mode) changes accord-
ing to the function where the mouse pointer actually hovers above. Always keep an eye on this needful 
information to identify the different functions, especially if you are not familiar with them.
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The Browser area2	

With the Browser you can easily explore all plug-ins, presets, projects and samples on your computer, as long 
as you have located all relevant folders in the Setup beforehand. Each global entry in the Browser grants 
direct access to the deposited folders without cumbersome navigation. Via the Disks entry you can also 
explore all drives of your computer. The Audio pool entry lists all samples that are currently in use by your 
Project. Next to the magnifying glass is the search field which helps to locate files quickly.

The main working area3	

The content of the main working area depends on the active view. It either shows the Modular, the Sequencer 
or the Mixer view. You can switch views by clicking on the respective entry in the global control area. The 
actual screenshot shows the Sequencer view. You can easily add additional views for VST instruments and 
effects, by selecting Add from the context menu, which proves especially useful for laptop users.

Basic functions
Before we go into detail with the application chapters it's necessary to understand the basics of energyXT. 
Some functions apply to all views, others only apply to one of the three views. The following paragraph 
headings include the view to which the described function applies to in brackets. 

Many functions are assigned to keyboard shortcuts. Refer to the function list under File > Setup > Shortcuts 
to look up or change shortcuts.

Navigation
Navigating through energyXT works in the same way as in every other application. However there are a 
few things you need to know.

Using the mouse wheel to zoom and navigate (All views)

You can use the mouse wheel to navigate through each view horizontally. Turning the mouse wheel with 
the Ctrl key depressed affects the horizontal zoom in the Sequencer view.

Entering values (All views)

You can change value entries in energyXT by either double-clicking on an entry and making a numeric 
entry with the keyboard or by click-holding the entry and dragging the mouse up to increase and down to 
decrease the value. A few entries can also be changed via context menus with a right-click.

Scrolling editor windows (All views)

You can scroll any editor window by dragging the mouse, with the right mouse button depressed, in any 
direction.

The transport controls (All views)

EnergyXT has five transport buttons which are similar to those you can find on most hi-fi recording units 
(e.g. MD recorder and tape deck). From left to right, the buttons are as follows:

Play: to start the song playback◊	

Stop: to stop the song playback◊	

Rewind: to go back to the beginning of a song◊	

Loop: loops the selected range for playback or recording◊	

Record: to start a recording with the selected tracks◊	
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The song position pointer and timer (Sequencer)

The song position pointer shows the actual playback position. It is represented by a vertical bar in the Se-
quencer view. By default, the position pointer causes the track view to scroll with the actual position during 
playback. You can place the song position pointer by clicking into the bar line above the displayed tracks.

The song position timer shows the actual position of the song position pointer. 
It is located next to the transport controls. You can change the format from bar 
count to time count by clicking on the display.

Edit functions

Setting a playback / recording range (Sequencer)

You can define a playback / recording range in the bar line. Click on 
the bar line and, with the mouse button depressed, draw the range 
from beginning to end. Once set, you can alter the range by moving 
the left and right edges with the mouse.

EnergyXT can loop the selected range for playback or recording. You 
can use this feature for overdub recordings. Click on the arrow next 
to the Record button in the transport controls to switch between 
loop and forward mode.

The Quick add button (Sequencer)

The Quick add button gives you quick access to all available tracks in energyXT. Click on the 
button and select a track template to easily add a new track to your project. Choose between 
Synthesizer, Drum sampler, Audio, Guitar Amp and VST tracks.

The grid snap function (Sequencer)

EnergyXT has a convenient grid function which causes the song position pointer 
to snap to predefined note values. This is especially useful to make exact selec-
tions and move Parts and notes on a musically time basis to rasterized positions.

You can activate / deactivate the grid function by clicking on the hash. Use the triangle to the right to set the 
grid value. To select triplet and dotted note values, set the 3 and the dot next to the hash active (orange). To 
switch between absolute and relative snap positions, use the arrow. The grid snap setting likewise defines 
the grid for the note quantization.

Editing Parts (Sequencer)

In energyXT, the content of each track is displayed as Parts on a timeline. Parts may have any size. A reason-
able length would be a few bars, e.g. for chorus and verse. Smaller Parts may represent short musical phrases 
which can be easily reused throughout the whole Project.

EnergyXT creates a new Part ranging from the beginning of the recording to the end with every new re-
cording. You can move Parts by grabbing the Part with the mouse and dragging it with the mouse button 
depressed to a new location on the same or another track. To make a copy of a Part, hold down the Ctrl key 
while dragging the Part. The length of each Part can be altered by moving the left and right edges with 
the mouse. You can select multiple Parts by clicking on the Parts' name with the Shift key depressed or by 
clicking into the track view and with the mouse button depressed drawing a selection rectangle.

Make use of the grid snap function to place Parts at musical positions.œœ
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Edit mode for tracks (Sequencer)

You can switch each track into 
edit mode by double clicking 
on its name. In edit mode, you 
see a more detailed view of 
the track content for editing. 
The view depends on the 
track type.

Instrument Tracks display ◊	
note events in a piano roll 
editor.

Audio Tracks display a ◊	
detailed view of the wave-
form.

Drum Tracks display note ◊	
events with additonal 
drum specific controller 
data entries.

All track types support the 
display of additional MIDI 
controller data. 

To change the vertical size of the edit view, grab the bottom of the track with the mouse and drag it up-
wards or downwards.

Naming tracks (Sequencer)

You can name tracks by right-clicking on the track and choosing Re-
name.

Rendering Project (All views)

Once you finished your song you'd probably want to export the Project to a 
sound file. EnergyXT offers a downmix function to finalize your music with 
all settings and effects. Choose File > Export Project (wav, aif, mp3) or use the 
quick button next 
to the transport 
controls to ren-
der a WAV, AIFF 
or MP3 file (en-
ergyXT2.5 only). 

Under Format, choose the quality and file type of 
your mixdown. You can either export the complete 
project or the selected playback / recording range. 
Click on Start and choose a destination and a proper 
name to complete the operation.

Exporting your project to MP3 format requires an MP3 encoder/decoder to be installed. œœ For more 
information, refer to the energyXT2.5 Quick Start Manual or visit www.energy-xt.com.

http://www.energy-xt.com
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Global settings

Song tempo / Signature (All views)

The song tempo and signature indicators show the current tempo in beats 
per minute (bpm) and the song's metric scheme. You can change both by 
clicking into the appropriate fields.

Info panels (Sequencer)

EnergyXT provides two info panels which show important options for the selected track or Part. The panels 
can be activated / deactivated by using the symbols next to the signature indicator. 

The horizontal panel grants access to important track and Part options◊	

The vertical panel displays the mixer channel strip of the track and gives full ◊	
access to all mixer functions.

Make sure that both panels are visible as they provide valuable information and edit options.œœ

Channel filters (Mixer)

In the Mixer view, you have access to all audio channels. By default all types of channels 
(Inputs, Outputs, Sends, Groups, Components) are displayed. You can choose which type of 
channel you want to see by clicking on + and checking the appropriate entries.

Mute and solo functions (Sequencer / Mixer)

You can switch tracks in the Sequencer view and channels in the Mixer view to Solo or Mute. 
You activate either entry by clicking on S (Solo) or M (Mute).

When you activate Solo only the selected track(s) / channel(s) are played back.◊	

When you activate Mute the selected track(s) / channel(s) are not played back.◊	

Accessing Components in energyXT (Modular)

EnergyXT features a powerful Modular view which can 
be regarded as a virtual patchbay. It allows for free signal 
distribution of MIDI and audio signals between physical 
inputs / outputs of hardware, virtual inputs / outputs 
of plug-ins and energyXT's Sequencer. Each element is 
called a Component and appears in the Modular view.

You can change the routing for each Component by 
right-clicking on its symbol. The context menu lists all 
possible input and output connections. Alternatively, you 
can connect the inputs / outputs of each Component by 
drawing a direct connection with the mouse. To do so, 
click on a connector square and, with the mouse button 

depressed, drag the mouse pointer to the square of the Component to which you want to connect the 
selected Component. You can always break an established connection with a right-click on an occupied 
connector square. 

The number of independent inputs and outputs for each Component is represented by a corresponding 
number of connector squares. Audio connections and connectors appear blue, MIDI connections appear 
green. Connections to physical inputs / outputs of your hardware are not displayed.
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Multitrack Audio RecorderChapter 4 

Target user: Podcaster, Songwriter, Sound Designer, Mastering-Engineer
EnergyXT offers extensive capabilities for recording audio signals. Audio signals are generated by micro-
phones when you record an acoustic instrument or a vocalist. Most commonly the signal of the microphone 
will pass a mixer and enter the computer through the audio interface. Some audio interfaces even allow 
for microphone signals to be plugged in directly. If so, you don't have to use an additional mixer unit. 
Another source of audio signals originate from guitars and keyboards. These instruments output an audio 
signal directly.

All audio signals that enter your computer can be recorded on Audio Tracks. Each Audio Track can be ei-
ther mono (1-channel) or stereo (2-channel). The possible sample rate for audio signals complies with all 
professional standards across the world as long as your audio interface lives up to the specs of energyXT. 
Audio signals can be recorded either one instrument after the other or you may record a group of signals 
simultaneously (e.g. a live band).

The Mixer of energyXT lets you create mixes of your audio recordings with additional effects and equalizer 
settings.

The setup
Basically there are three different setups for recording audio signals in energyXT. 

With a 2-channel (stereo) audio interface, you can either

record up to two mono signals on two dedicated Audio Tracks or one stereo signal on a single Audio ◊	
Track. Each Audio Track then carries the dedicated input signal.

record several signals as a mix on a stereo track. The Audio Track then carries a mixed version of the ◊	
input signals.

With a multi-channel audio interface, you can also

record several input signals on dedicated Audio Tracks. Each Audio Track then carries the dedicated  ◊	
input signal. 

The maximum number of independent record signals depends on the number of input channels œœ
of your audio interface and the energyXT version you are using (compare with table on page 6).

If you want to record instruments (either mono or stereo) one after the other, it's sufficient to use a 2-channel 
audio interface.

If you want to record a live rehearsal (e.g. band performance) and like to create a mix later on, you should 
record each input signal on a dedicated Audio Track with a multi-channel audio interface.

See the application examples on how to make the necessary connections for 2-channel and multi-channel 
recordings.
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2-channel setup

You need

a 2-channel audio interface with microphone inputs◊	

or

a 2-channel audio interface with line inputs and a mixer.◊	

A suitable combination of an audio interface and a mixer is always desirable as it gives way more œœ
flexibility for different recording purposes. Actually it is a prerequisite if you want to record a signal 
mix with a 2-channel audio interface.

FIREWIRE 1

CD/TAPE INPUT
Laptop

CTRL ROOM
OUT

LINE IN 3/4

ANALOG OUT

CD Player

LINE IN 2MIC IN 1

Microphone
(e.g. BEHRINGER B-2 PRO)

Analog Mixer
(e.g. BEHRINGER

XENYX 802)

Electric Guitar

DI
Box

BAL/UNBAL OUT
CD/TAPE OUTPUT

UNBAL IN

FIREWIRE
Audio Interface (e.g. BEHRINGER FCA 202)

INPUTS

Active Monitor Speakers
(e.g. BEHRINGER MS40)
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Multi-channel setup

You need

a multi-channel audio interface with microphone inputs ◊	

or

a multi-channel audio interface with line inputs and a mixer with direct outputs.◊	

Active Monitor Speakers (e.g. BEHRINGER MS40)

INPUTS
Multi-channel

Audio
Interface

Analog Mixer
(e.g. BEHRINGER
XENYX 2222FX)

ANALOG IN 1-8

Laptop

CHANNEL INSERTS 1-8

LINE IN 7-8

ANALOG OUT 1-2

E-Drums

Bass Head
(e.g. BEHRINGER

BX4500H)

Bass Guitar

Electric Guitar

LINE IN 6

LINE IN 3

Guitar Amp
(e.g. BEHRINGER 

LX210)

Microphone
(e.g. BEHRINGER B-2 PRO)

LINE IN 4-5

Keyboard

MIC IN 1/2

FIREWIRE FIREWIRE
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Audio recording step by step
The following section will show you how to make use of the full audio potential of energyXT. On the basis 
of a typical recording application, all important aspects of audio recording are covered from adjusting input 
signal levels up to the final mix.

Before you follow the instructions below, make sure you've already set up your computer and œœ
energyXT properly. See chapter "Setup" for details.

Each paragraph heading outlines the main steps you need to undergo to perform a typical audio recording. 
You may follow all of the paragraphs or simply pick the ones that are of interest to you. However, it might 
be useful to read all texts to get to know all the possibilities energyXT has to offer.

For better understanding, the guide reflects a real-life recording example by recording two acoustic instru-
ments (guitar, vocals) one after the other and then adding a drum loop. You will learn how to record audio 
signals and mixdown all recorded tracks with effects. Later on, you may want to take this demo Project as 
a starting point and tailor it to your needs. Keep track of the demo Project's progress by reading the text 
after each diary icon.

Creating a Project
Before you can make a recording you have to create a Project. 
The Project is the foundation for your song and holds all musical 
data, settings and parameters.

To create a Project:

Go to i.	 File > New Project.
Alternatively choose the respective template from the Welcome 
screen.

Choose ii.	 File > Save as... to call up the save dialog.

Choose a folder for your Projects.iii.	
The save dialog of energyXT is similar to that of the Windows 
Explorer user interface. The left column shows the folder tree of 
your drives and the right column lists all subfolders and energyXT 
related files that are present in the selected folder. The selected 
folder path is displayed at the top of the window.

Under iv.	 File:, enter a reasonable name for your Project.

Click on v.	 OK to save the Project.

You must save your Project before you start a recording.œœ

In our example we created a new Project called 		 Audio recording example and saved it to D:energyXT Projects.

Adding Audio Tracks
Audio Tracks in energyXT either carry a mono or a stereo signal. The quality of the recorded audio signal 
depends on the settings in the Setup. See chapter "Setting up your audio interface" for details. Common 
sample settings include 24-bits / 96000 Hz for DVD-A / SACD and 16-bits / 44100 Hz for CDDA.
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To add an Audio Track:

In the Sequencer view from the menu, choose i.	 Track > Add New > Audio Track.
Alternatively, use the context menu on the empty track column or select an already present Audio Track and double-
click into the track column to add a new track.

You may name each track to identify ii.	
it easily. See chapter "Naming tracks 
(Sequencer)" for details.

From the info panel, choose a record-iii.	
ing format.
Select Stereo for signal sources such as CD 
players and keyboards.

Select Mono for signal sources such as a 
microphone and guitar signal.

Alternatively, you can use the œœ Quick add button next to the bar line to add a new track.

In our example we created two stereo tracks named 		 Guitar and Drums and a mono track for the Vocals.

Routing audio inputs and outputs
By default each Audio Track is connected to an available input / output Component of energyXT. See chapter 
"Accessing Components in energyXT (Modular)" for details on Components. The actual routing appears in 
the Input and Output fields of the info panel. 

If you have a 2-channel audio interface:

or only activate two channels of a multi-channel 
interface in energyXT's Setup: 

Choose i.	 Audio In as Input and Audio Out as Output, 
if not already preselected.

If you have a multi-channel audio interface:

Choose the i.	 Input and Output of your audio inter-
face from the drop-down list. 
The entries are named consecutively in pairs, e.g. [1+2] 
Audio In, [2+3] Audio In. Choose the Input and Output according to the connections you made to your audio inter-
face.

It is possible to mix input signals by activating more than one Audio In Component of an Audio œœ
Track. The same goes for the output.

In our example we set all Audio Tracks to the default 		 Audio In and Audio Out routing.

Monitor settings
The monitoring determines whether the input signal can be heard or not. By default the input signal is 
always active. However, you may want to change the option depending on your hardware setup to prevent 
audio feedback loops.
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The monitoring options in energyXT are as follows:

Off◊	 : Disables monitoring.

Auto◊	 : Enables monitoring anytime (Default setting).

Record◊	 : Enables monitoring only during recording.

Manual◊	 : Enables monitoring only if the monitoring for 
each track is activated in the track column.

To adjust the monitoring settings:

From the menu, choose i.	 Options > Monitor and select 
the appropriate setting.

In our example we chose the default setting 		 Auto.

Setting the input signal level
Setting a proper signal level for the input signal is very important in order to avoid annoying 
artifacts.

If the level of the input signal is 

too high the signal will distort.◊	

too low the signal probably will be covered with noise and results in a falsified sound.◊	

You can adjust the level of the input signal in the Mixer view. The Mixer is organized in channel 
strips. 

To set a proper input signal level, you need to be familiar with the following elements:

The Trim for boosting or lowering the input signal level at the top.◊	

The level fader with the corresponding level meter at the bottom.◊	

To adjust the level of the input signal properly:

In the Mixer view, identify the input channel strip to which your signal is connected (e.g. i.	 Audio 
In, [1+2] Audio In).
The channel name corresponds to the input Component you selected for the recording track in the Sequencer view 
(Audio In in Sequencer view = Audio In in Mixer view). See chapter "Routing audio inputs and outputs".

Make sure that you set the Monitor setting correctly if you hear no input signal. See chapter "ii.	 Monitor 
settings".

Play your instrument or playback the signal you have connected to your audio interface and observe iii.	
the level meter next to the level fader.

Adjust the level of the input signal at your audio interface according to the user manual of the unit in iv.	
case your audio interface includes a control for trimming the signal level.

Adjust the level of the input signal further with the Trim so that the peak amplitude of the signal barely v.	
causes the level meter to reach the top.

Reduce the recording level with the level fader, if needed.vi.	

In our example we adjusted the input signal level with the Trim to +12 dB and left the level fader at its default 0.00 dB position.		
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Configuring the metronome
If you want to record several instruments one after the other it is critical that you 
perform your music as exactly as possible to a given song tempo when recording. 
In energyXT, you can use a metronome which, like its real counterpart, produces 
an audible click, the beat.

To set the tempo:

Input the song tempo into the field next to the transport controls.i.	

To configure the metronome:

Right-click on the metronome icon.i.	

Choose the number of beats per bar (1 to 8 beats). ii.	
E.g. 4 beats to count quarter notes for a 4/4 time signature.

Check the iii.	 Count-In entry if you want to have a one bar precount before the recording starts.

Check the iv.	 Playback and Recording entries if you want to hear the metronome's click during playback 
and recording.

Select a volume for the click under the v.	 Volume entry.

Check the vi.	 Enable entry to activate the metronome.
Alternatively, you can left-click the metronome symbol to enable / disable the metronome.

In our example we chose a song tempo of 100 bpm and enabled the metronome with a one bar precount to count quarter notes during 		
a recording.

Recording takes
Among musicians a recording is most commonly known as a take. A take can be just a few bars of length or 
even cover the whole song. For each take energyXT creates a Part from the beginning of the recording to 
its end. Parts can be modified later on in various ways as described in chapters "Editing Parts (Sequencer)" 
and "Working with patterns".

To record a take:

In the Sequencer view, select an Audio Track for recording.i.	

Set a recording range in the bar line if you know the length of your musical performance.ii.	
Alternatively, turn off loop mode and set a zero range, if you can't predict the length of your recording.

Place the song position pointer at the very beginning of the song or at the beginning of your record-iii.	
ing range.
Remember to use the grid function to place the song position pointer exactly at musical units (see chapter "The grid 
snap function (Sequencer)").

Click the Record button in the transport controls to start the recording.iv.	
If you have activated the metronome's Count-In, the recording 
starts with the secondly counted bar.

Perform your music.v.	
EnergyXT creates a Part for your recording.
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Click on the Stop button in the transport controls to stop the recording.vi.	
The Part ends as soon as you stop the recording.

In our example we recorded a 4 bar Guitar take from the beginning of the song. 		
Exchanging a part of a recorded take with a new recording
Assuming that you have recorded a good take with just a small mistake you don't necessarily have to record 
the whole performance again. In fact you could pick a musically reasonable slice of your take (e.g. two bars) 
which includes the mistake and replace just this small slice with a new recording. Audio engineers call this 
a punch recording, as you jump in with your new recording for just a predefined range.

However, this course of action is only possible if the signal contains enough silence (signal pauses) at which 
you can cut the audio material properly without getting annoying artifacts such as a truncated sound. A 
signal pause in the waveform view appears flat.

To exchange a slice of a recording with a new recording:

In the Sequencer view, enter the track's edit view.i.	

Disable the grid snap function.ii.	

In the recorded Part you wish to exchange a few bars, locate a signal pause at the beginning of the iii.	
range you wish to re-record and place the song position pointer.
Use the zoom function for easy navigation.

From the menu, choose iv.	 Part > Split to split the Part into two pieces.

Locate a signal pause at the end of the range you wish to re-record and place the song position v.	
pointer.

From the menu choose vi.	 Part > Split to isolate the slice.
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Select the isolated Part (slice) and choose vii.	 Part > Delete to delete it.

Activate the grid snap function and set the grid to viii.	 Bars.

Set the recording range in the bar line to the range of the now missing slice.ix.	

Place the song position pointer at the beginning of the recording range.x.	

Redo the recording.xi.	
If you activate the loop mode, you may record several takes one after the other. 

Adjust the edges of the newly recorded Part to match the gap between the surrounding Parts.xii.	
It might be useful to overlap the surrounding Parts slightly if otherwise the sound gets truncated. Disable the grid 
snap function to freely adjust the edges of the Parts. Overlapping Parts will be mixed.

In our example we replaced a slice of the vocal take (bars 2-3) with a new recording.		
Working with patterns
EnergyXT displays recordings as 
Parts in a timeline. This concept 
facilitates a pattern oriented 
workflow as you can reuse mu-
sical phrases throughout the 
song. This is extremely useful 
if you have a traditional song 
layout with verse and chorus. 
Even if you do not have a tradi-
tional song structure it is at least 
useful to use short phrases, riffs 
or elements again.

To create a reusable pattern:
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Split your recorded takes to musically reasonable Parts (e.g. verse, chorus, riff, solo).i.	
Make use of the grid snap function to split Parts from bar to bar.

Select the Parts you wish to reuse.ii.	

Hold the iii.	 Ctrl key, grab the Parts with the mouse and drag them to a new position in the timeline.

In our example we created a copy of the Guitar and Vocal Parts from bars 1-5 and moved this pattern to bars 9-13.		
Creating dynamic volume changes (energyXT2.5 only)
You can use dynamic envelopes to control certain parameters of the mixer for each Part. The parameters 
include volume, pan, mute, EQ and parameters of VST effects, if any are being used in the Audio Track. An 
envelope describes the parameter setting at any given song position.

Each envelope parameter can be edited in its own window. Possible applications range from simple volume 
fades (e.g. fade in / out) to a fully fledged dynamic mixer automation with changes in panorama, volume 
and effect parameters. 

To create a volume envelope:

In the Sequencer view, enter the track's edit view.i.	

Click on the + symbol and check the ii.	 volume entry.
At the bottom of each Part appears an edit window for the volume parameter.

Set the grid snap function to iii.	 4 to place nodes at quarter note values.
You may choose smaller note values to create more envelope nodes for more detailed envelopes.

Add two envelope nodes by double-clicking into the iv.	 Volume edit window of a Part to create a fade in. 
Place one node at the very beginning and the second a few quarters behind.
Envelope nodes are indicated by small squares and can be positioned horizontally and vertically by dragging them 
to the wanted position.
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Use the mouse to drag the first node to the bottom (minimum volume) and the second to the top of v.	
the edit window (maximum volume).

Create another node at an intermediate volume position to slowly lower the track's volume.vi.	

To hold the reduced level, create another node.vii.	

Add a final node at the end of your Part to create a fade out.viii.	
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Curve the fade in / out by dragging down the circle in between the nodes with the mouse to create ix.	
a smooth fade.

These are the basics on how to work with envelopes. From this example you may go ahead and create your 
own envelopes for various parameters (e.g. Pan, EQ).

In our example we created a simple volume envelope with a curved fade in and fade out in the Guitar track.		
Embedding loop samples
With loop samples you can easily create songs of professional sound quality. A loop sample appears as a 
Part in the timeline and can be used throughout the song just like any other audio Part. 

As we speak of pre-recorded phrases it goes without saying that every phrase comes with a predefined 
tempo which most likely does not match your song's tempo. To address this problem, energyXT offers con-
venient options to change the tempo of loop samples so that each perfectly syncs to your song's tempo. 
This is commonly known as resampling.

There are two basic modes to resample loops in energyXT:

Stretch: alters the tempo of the loop sample, without changing the pitch.◊	

Re-pitch: alters the pitch and the tempo of the loop sample.◊	

Stretch should be your first choice if you want to change the length of a loop sample, as it conserves œœ
the original sound and harmony.

Although quite powerful, you should only use these modes to adapt loop samples that already are close 
to your song's tempo. Changing the length of the original sample too much will lead to a poor and dete-
riorated sound.

Alternatively you may want to use resampling to create special effects by changing the length of the sample 
loop drastically.
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To resample a sample loop that doesn't match your song's tempo:

In the Sequencer view, select the name entry of a loop sample from the Browser window and, with the i.	
mouse button depressed, drag it onto an Audio Track.

Set the grid snap function to ii.	 Bar.

Select the Part with your loop sample and move it to the beginning of a bar.iii.	

Choose iv.	 Stretch as the resample mode from the info panel.

Move the right edge of the Part to the next bar where you wish the loop sample to end.v.	
EnergyXT automatically adjusts the end of the Part to the nearest bar. However, you may alter the length manually, 
according to your needs.

Use the vi.	 Coarse and Fine parameters in the info panel to adjust the pitch of the loop sample. 

In our example we imported a loop sample with a tempo of 120 bpm into a song with 100 bpm and used the Stretch mode to extend 		
the sample to fit into two bars.
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Editing audio
You can edit your audio material directly within energyXT. Just double-click on the Part you wish to edit 
and you get access to common audio editing functions, such as Normalize, Fade In/Fade Out, Delete, Cut, 
Trim and Reverse. 

Functions of the Audio editor:

Normalize◊	 : Adjusts/increases the amplitude of the audio signal without introducing distortion.

Delete◊	 : Deletes a selected range within the waveform and inserts silence.

Cut◊	 : Deletes a selected range within the waveform and glues the remaining parts at the point of 
intersection.

Trim◊	 : Deletes the parts of the waveform left and right to the selected range.

Reverse◊	 : Reverses the audio material of the selected range within the waveform.

Fade In/Out◊	 :  Fades in or fades out the volume of the selected range.

Crossfade
You can also create Crossfades with energyXT. A Crossfade makes a smooth transition between two over-
lapping audio Parts.

Select two overlapping Parts.i.	

Right-click and select ii.	 Process > Crossfade.

Beatslice
Beatslicing is a technique to 'slice' any audio Part (e.g. drum loops) into its specific (rhythmic) elements.

EnergyXT offers an Autoslice function, that automatically detects the specific parts within the audio mate-
rial. Alternatively you can use the Beatslice function, that allows you to modify the position of the slices 
yourself.

Right-click on a Part you wish to beatslice.i.	

Select ii.	 Beatslice or Autoslice to slice the material.
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Creating a mix
All audio signals run together in the Mixer. The Mixer view shows a channel strip for each input, 
output and Audio Track Component which grants access to volume and pan position. You may 
additionally manipulate the audio stream with any kind of VST effect and energyXT's EQ.

The channel strip shows (from top to bottom):

The name of the input Component◊	

The eq band◊	

The insert effects for the channel◊	

The available send controls for the send effects◊	

The Pan control (panorama position)◊	

The level fader with the corresponding level meter and the mute (M) and solo (S) buttons◊	

The name of the output Component to which the channel is routed◊	

The name of the Component (e.g. name of the Audio Track or audio input)◊	

Adjusting channel volume and Pan
The most important controls to adjust the audio signal are volume and pan. Use the level fader 
to control the volume of each channel and the Pan control to place the signal to any position in 
the stereo field from fully left to fully right.

To adjust the volume and the panorama for a channel:

In the Mixer view, grab the fader control with the mouse and drag it to the wanted position i.	
to set the level.
The value of amplification is displayed in dB above the fader.

Grab the Pan control with the mouse and drag the mouse up or down to move the signal off ii.	
the center position to the right or left to set the panorama of a channel.

In our example we moved the Guitar slightly off center to a position of L15 to the left and lowered the channel's volume 		
to -3.03 dB.

Using send / insert effects
Each channel of the Mixer supports the use of effects. You can either use energyXT's own Multi Effect or 
use any type of VST compatible effect. 

EnergyXT supports two types of effect integration:

Insert effects are channel-only effects. They only affect the signal of the channel where they are applied ◊	
to. Typical effect types to be used as an insert effect include chorus, compressor and noise gate.

Send effects are global effects. They can be accessed by multiple channels in parallel. The input of a ◊	
send effect comprises of the signal amount of channels that output their signal via a send control to 
the send effect. Typical effect types to be used as a send effect include reverb and delay.
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To add an insert effect to a channel:

In the Mixer view, select the name entry of an effect in the Browser window and, with the mouse button i.	
depressed, drag it into the insert effect's section.
The insert effect is instantly active and will be displayed in the insert effect's section.

With the mouse button depressed, drag the FX level control up and down to adjust the wet / dry mix ii.	
(ratio of effect signal to original signal).
A setting of 100 (%) means the signal is fully conducted to the insert effect. A setting of 0 (%) means the signal fully 
bypasses the insert effect. Other settings define the mix between these two extremes.
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Make sure to adjust the effect's wet / dry mix to output only the effect signal, in order to render œœ
the FX level control of energyXT effectively.

Click on the power symbol to bypass the effect quickly for monitoring purposes.iii.	

In our example we added energyXT's Multi Effect as an insert effect to the Guitar track.		
To add a send effect to a channel:

In the Mixer view, select the name entry of an effect in the Browser window and, with the mouse button i.	
depressed, drag it into the send effect's section.
The send effect is instantly active and will appear as an additional channel in the mixer. All audio channels now feature 
a FX Send level control.

With the mouse button depressed, drag the FX Send level control up and down to adjust the signal ii.	
portion that will be send to the send effect.
A setting of 100 (%) means the signal is fully conducted to the send effect. A setting of 0 (%) means the signal fully 
bypasses the send effect. Other settings define the mix between these two extremes.

Make sure to adjust the effect's wet / dry mix to output only the effect signal, so that the wet / œœ
dry mix is the result of the FX Send level setting and the position of the level fader of the send 
effect channel.
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Shaping sound with the equalizer
EnergyXT features an internal equalizer for each channel. With the equalizer you can shape the sound of 
a signal. You may use the equalizer to eliminate unwanted signal frequencies (e.g. floor noise) or to shape 
the overall sound character of a signal. 

For each of the four available frequency bands, you may choose one of five different filter types:

Low Shelf (◊	 LSH): Shelving filter for low frequencies. It is used to adjust all frequencies below a set corner 
frequency.

Parametric EQ (◊	 PEQ): Peaking filter which selectively adjusts frequencies around a set center frequency. 
It is used to shape the overall sound of a signal.

High shelf (◊	 HSH): Shelving filter for high frequencies. It is used to adjust all frequencies above a set 
corner frequency.

Low Pass Filter (◊	 LPF): Frequency pass filter for the lows. It is used to eliminate unwanted high frequen-
cies above a set corner frequency.

High Pass Filter (◊	 HPF): Frequency pass filter for the highs. It is used to completely eliminate unwanted 
low frequencies below a set corner frequency.

Choose the appropriate filter types (EQ1 - EQ4) for each channel according to your application. By default 
the equalizer includes a classic configuration of high-shelf filter, two parametric equalizers and a low-shelf 
filter.

The parameters for each filter type include:

Frequency: to adjust the frequency for each frequency band◊	

Gain: to set the boost / cut for each frequency band◊	

Bandwidth (LSH, PEQ, HSH only): to adjust the width of the frequency band that should be affected by ◊	
the filter (also known as Q factor)

To use the equalizer:

In the Mixer view, choose the EQ frequency band (EQ1 - EQ4) in the channel strip.i.	

Click on the power symbol to activate the frequency band.ii.	

Click on the abbreviation and choose the appropriate filter type from the drop-down list for iii.	
each frequency band.

Choose a control and with the mouse button depressed move the mouse up and down to adjust iv.	
frequency, bandwidth and gain.

In our example we added the equalizer to the Guitar track and used the original equalizer's setup with a high-shelf filter, two parametric 		
EQs and a low-shelf filter.

Creating submix groups
EnergyXT supports the use of submix groups. Channels which are assigned to a submix group will be 
pre-mixed and can be controlled easily as a group. This technique is often used to be able to control the 
volume of an instrument ensemble with a single level fader and concurrently maintain signal balancing. 
Moreover you can apply the same effect (e.g. compression) to the Group which is common practice when 
creating a final mix.
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To use a submix group:

In the Mixer view, select i.	 Add group to add a submix group.
A Group channel appears next to the Audio Track channels which is routed to the audio output Component by 
default.

From the context menu of the channel, select ii.	 Rename to give a reasonable name to the Group.

From the drop-down list of an audio channel's output, check the name of the Group to route the chan-iii.	
nel to the newly created Group.
You may choose multiple output channels for your channels. However, the most common practice is to route the 
channel only to the relevant Group. Otherwise the signal is routed to the audio output twice.

In our example we created a submix group with the default name Group and routed the output of the Vocals channel to the newly 		
created Group.

Remote mixing
Many parameters of the Mixer can be controlled remotely with a suitable DAW controller. With a hardware 
controller it is much easier and more intuitive to control volume fades and changes than doing it with the 
mouse. 

EnergyXT works with all types of DAW controllers, provided they output standard MIDI controller data 
and not system exclusive data. To adjust the Mixer's response to your DAW controller, it first needs to be 
calibrated. A MIDI learn function offers a convenient way to do so quickly.
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Setting up your hardware

See the application example below on how to make the necessary connections.

Laptop

Active Monitor Speakers (e.g. BEHRINGER MS40)

Audio Interface
(e.g. BEHRINGER FCA202)

DAW MIDI Controller (e.g. BEHRINGER BCF2000)

USB

ANALOG
INPUTS

BAL/UNBAL OUT FIREWIRE 1

FIREWIRE

USB

To calibrate the Mixer and your DAW controller:

Click on the MIDI indicator next to the metronome symbol to open the MIDI controller mapping i.	
dialog.

Click on the keyboard symbol to use the MIDI learn function.ii.	
EnergyXT now waits for a control element to be moved as a control target.
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Grab and drag the control element that you want to calibrate with the mouse (e.g. level fader).iii.	
The Controller map dialog displays the parameter's name.

Turn the control of your DAW controller up and down to assign the control of your hardware to the iv.	
control element of the software.

Repeat steps iii.-iv. for every control you want to control remotely.v.	

Click on the keyboard symbol in the Controller map dialog to finish the calibration.vi.	

Alter the values in the vii.	 Range fields to restrict the control range for a more precise input, if needed.

You can use the Controller map dialog in the same way if you want to assign hardware controls œœ
to the parameters of send / insert VST effects.

To create a track for recording the controller data:

Switch to the Mixer view.viii.	

From the menu, choose ix.	 Track > Add New > Instrument Track to add an Instrument Track.

Select the Instrument Track and, in the info panel under the entry x.	 Output, check all Audio Tracks for 
which you want to record controller movements.
The Instrument Track is now ready to record and playback controller data. See chapter "Recording takes" for details 
on how to proceed with the recording.

In our example we assigned MIDI controller CC91 to the level fader of the Guitar track, created an Instrument Track to record controller 		
data  and selected the Guitar track as the destination of the Instrument Track.
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Multiple track recording
EnergyXT allows simultaneous recording of different signals on multiple tracks. There are a lot of applica-
tions where you may want to record several musicians at once, may it be in a concert situation or just two 
instrumentalists playing in your studio, and thus need the possibility to record multiple signals independently. 
EnergyXT smoothly supports this kind of workflow and simplifies things due to its portability.

Changing the configuration of Audio In Components
When recording on several tracks it is essential that you care about 
the routing for each Audio Track beforehand to determine which 
input signal reaches what track. By default every audio input pair 
of a multi-channel audio interface is represented by an Audio In  
Component named [1+2] Audio In, [2+3] Audio In and so on (see 
the picture of the Modular view for an audio interface with eight 
input channels).

Each of the Audio In Components conducts the two respective 
signals (a stereo pair) of your audio interface's inputs by default. 
If you only record stereo signals the only thing you have to do is 
choose the correct Audio In Component as the input for each Audio 
Track in the Sequencer view as described in chapter Routing audio 
inputs and outputs" and set the format of the Audio Track to Stereo. 
However, if your source signals are of mixed mono and stereo type you have to re-configure the Audio In 
Components in the Modular view.

To change the configuration of an existing input Component for mixed mono and stereo applica-
tions:

In the Modular view, choose the entry i.	 Audio In from the context menu and add the necessary amount 
of input Components for each mono input you want to use.

By default the Modular view shows the inputs of your audio interface in groups of input Compo-œœ
nents ready for stereo use (e.g. four input Components for eight input channels).
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To create mono Audio In Components:

Choose one input channel as Input for each Audio In Component.ii.	

 

To create stereo Audio In Components:

Choose two input channels as Input for each Audio In Component.iii.	

Via the context menu, rename all Audio In components such that the names correspond to the respec-iv.	
tive input channels for easy reference (e.g. [1] Audio In, [2] Audio In, ... [7+8] Audio In).
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Switch to the Sequencer view.v.	

Create the necessary number of Audio Tracks (one track for mono and stereo signals) to record each vi.	
input signal on a dedicated track.
E.g. for an 8-channel audio interface: Six tracks for mono signals, one track for a stereo signal.

Choose vii.	 Mono as the record format for mono signals or Stereo as the record format for stereo signals 
for each Audio Track.

 

Choose the correct Audio In Component from the drop-down list as the input for each track.viii.	
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Select all tracks by holding ix.	 Ctrl and clicking on the name of each track consecutively.

Click on the Record symbol in the transport controls to start the multi-track recording.x.	

In our example we mapped the eight input channels of an audio interface to six mono and one stereo Audio In Components. After renaming 		
the Components we created seven tracks in the Sequencer view and chose the appropriate Audio In Component such that all mono input 
signals are recorded on dedicated tracks and the stereo input signal shares another track.

Editing multiple Parts simultaneously
When you have recorded multiple tracks at once, each track is in timely correlation to each other. If you now 
want to cut or move the Parts you must make sure that all tracks remain in sync. Instead of editing Parts one 
after the other you therefore can select multiple Parts and edit them simultaneously.

To edit multiple Parts at once:

Select the Parts you want to edit simultaneously.i.	

Carry out the operation you want to apply to all selected Parts.ii.	
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MIDI SequencerChapter 5 

Target user: MIDI-Producer, Songwriter, DJ
EnergyXT provides a wealth of functionality for editing and manipulating MIDI data to create state-of-the-
art music compositions. There are several applications that might come to one's mind: Nowadays, the most 
common application would be to create a complete virtual studio setup solely with software plug-ins which 
is energyXT's major domain. A more traditional setup would be to use the software only for recording from 
and playing back MIDI data to hardware tone generators.

MIDI data is most commonly produced with a suitable hardware device such as a master keyboard, although 
you may also create a song solely by using the MIDI editors of energyXT. With an adequate DAW hardware 
controller you may control certain energyXT functions which proves especially useful to control several 
plug-in parameters or Mixer controls more comfortably and intuitively than with a mouse.

The setup
Basically, there are two different conceivable setups for working with MIDI. See the application examples 
on how to make the necessary connections.

MIDI setup with a master keyboard and virtual tone generators
In this application, the sound is merely produced from virtual tone generators (e.g. VST plug-ins). The control-
ler keyboard is needed to input MIDI data. With an integrated solution, such as the depicted audio interface / 
MIDI keyboard combination, you have all necessary hardware for this application unified in a single unit.

What you need

a master keyboard with audio capabilities or a master keyboard plus an external audio interface.◊	

Active Monitor Speakers
(e.g. BEHRINGER MS40)

ANALOG
INPUTS

LINE OUT

Controller Keyboard/Audio Interface
(e.g. BEHRINGER UMA25S)

USB

Laptop

USB
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MIDI setup with hardware tone generators
In this application, the sound is solely being produced by external hardware tone generators (e.g. sound 
sampler and sound module). The MIDI keyboard is needed to input MIDI data.

What you need

a master keyboard with integrated tone generation to input and playback MIDI data or a controller ◊	
keyboad plus external tone generators.

MIDI Controller Keyboard
(e.g. BEHRINGER UMX49) Laptop

Analog Mixer
(e.g. BEHRINGER XENYX 1204)

Active Monitor Speakers
(e.g. BEHRINGER MS40)
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Sound Module MIDI THRU LINE IN 3
LINE OUT L

USB

LINE IN 4

MIDI IN

LINE IN 1

LINE IN 2

ANALOG IN

ANALOG
INPUTS CD/TAPE

OUTPUT

CONTROL
ROOM OUT

LINE OUT R

USB

MIDI IN
MIDI OUT



44

MIDI Sequencer

MIDI recording step by step
The following section will show you how to make use of the full MIDI potential of energyXT. On the basis of 
a typical recording application, all important aspects of MIDI-based music recording are covered.

Before you follow the instructions below, make sure you've already set up your computer and œœ
energyXT properly. See chapter "Setup" for details.

Each paragraph heading outlines the main steps you need to undergo to do a typical MIDI recording. You 
may follow all of the paragraphs or just pick the ones that are of interest to you. However, it might be useful 
to read all texts to get to know all the possibilities energyXT has to offer.

For better understanding the guide reflects a real-life recording example, which is to record two MIDI instru-
ments one after the other and add some drums with the integrated Drum Sampler. You will learn how to 
record MIDI data, use virtual instrument plug-ins and edit and manipulate your recordings. Later on, you 
may take this demo Project as a starting point and tailor it to your needs. Keep track of the demo Project's 
progress by reading the text after each diary icon.

Creating a Project
Before you can make a recording you have to create a Project. 
The Project is the foundation for your song and contains all 
musical data, settings and parameters.

To create a Project:

Go to i.	 File > New Project.
Alternatively choose the respective template from the Welcome 
screen..

Choose ii.	 File > Save as... to call up the save dialog.

Choose a folder for your Projects.iii.	
The save dialog of energyXT is similar to that of the Windows 
Explorer user interface. The left column shows the folder tree of 
your drives and the right column lists all subfolders and energyXT 
related files that are present in the selected folder. The selected 
folder path is displayed at the top of the window.

Under iv.	 File:, enter a reasonable name for your Project.

Click v.	 OK, to save the Project.

In our example we created a new Project called 		 MIDI recording example and saved it to D:energyXT Projects.
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Adding Instrument Tracks
The common track type for MIDI data in energyXT is the Instrument Track. It either carries only the recorded 
MIDI events for an external tone generator or it immediately hosts the tone generation by means of a virtual 
VST instrument likewise.

To add an Instrument Track:

In the Sequencer view from the menu, choose i.	 Track > 
Add New > Instrument Track.
Alternatively, use the context menu on the empty track column 
or select an already present Instrument Track and double-click 
into the track column to add a new track.

You may name each track to identify it easily. See chap-ii.	
ter "Naming tracks (Sequencer)" for details.

Alternatively, you can use the œœ Quick add button next 
to the bar line to add a new track.

In our example we created two Instrument Tracks named 		 Lead and 
Bass.

Using virtual instruments
Each Instrument Track can host a virtual instrument plug-in. EnergyXT supports both common VST instru-
ments and its own powerful Synthesizer plug-in.

To add a virtual instrument to an Instrument Track:

In the Sequencer view from the Browser window either choose a VST instrument or the energyXT Synthe-i.	
sizer. Select the name entry, and with the mouse button depressed, drag it onto an Instrument Track.
The name of the virtual instrument appears below the track's name. By clicking on its name you can access the control 
page of the instrument.

You can create a new Instrument Track with a virtual instrument already included by dragging the œœ
instrument's entry from the Browser onto the track column directly below the last track.
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Choose an entry from the ii.	 Program drop-down list in the info panel to select a preset sound for a virtual 
instrument, if available.

In our example we added energyXT's proprietary Synthesizer to the Lead track and the Crystal VST instrument to the Bass track.		
Routing MIDI inputs and outputs
On each Instrument Track you can record MIDI data either from a single physical MIDI input device or from 
several MIDI input devices (energyXT2.5 only). Likewise, you can either play back to a single or to several 
external / virtual instruments and Mixer channels. The appropriate routing can be done in the Sequencer 
view.

To determine the routing for an Instrument Track:

In the Sequencer view, select an Instrument Track.i.	

From the info panel, check one or more Input Component(s) from the drop-down list.ii.	
By default any physical MIDI input device is mapped to the basic MIDI In Component which is pre-selected for any 
Instrument Track.

In energyXT2.5 Compact, you can only have a single physical MIDI device active.œœ

Check the appropriate Output Component(s) from the drop-down list.iii.	
External tone generators, which are connected to a physical MIDI input device, appear as MIDI In. You may also choose 
a Mixer channel as a target.

Virtual instruments are assigned automatically to their Instrument Track.œœ
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Creating additional MIDI In Components for multiple input devices

By default energyXT creates a single MIDI In Component to which all active physical MIDI input devices are 
assigned. That means, the MIDI signal of each device is merged in the MIDI In Component, which in most 
cases is useful. 

However, if you have several MIDI input devices connected you may want to individually assign these to 
different tracks. In this case, you have to create the needed amount of MIDI In Components in the Modular 
View and assign all physical devices accordingly.

To create MIDI In Components for multiple input devices:

In the Modular view from the context menu, choose i.	 MIDI In.
A new MIDI In Component appears.

In the Component's context menu under ii.	 Device, check a physical MIDI input device.



48

MIDI Sequencer

In the context menu of the existing MIDI In Component, check another physical MIDI input device.iii.	
Now each Audio In Component is assigned to a different physical MIDI input device.

Repeat steps i.-ii. for other MIDI input devices you want to use.iv.	

From the context menu of a MIDI In Component, choose v.	 Rename... to name each Component prop-
erly.

In our example we created a new MIDI In Component and assigned one of two available physical MIDI input devices to the newly created 		
MIDI In Component and the second to the initially available MIDI In Component.

MIDI thru settings (MIDI monitoring)
The MIDI thru setting is the counterpart of the Monitor setting for audio signals. It determines the pass-
through for MIDI input data, thus serves as a monitor function. In most cases the default setting Auto needn't 
be changed, especially not when working with virtual instruments. However, if you have a master keyboard 
with internal tone generation and switched the Local setting of the keyboard to On you may want to disable 
MIDI thru in energyXT to prevent the tone generation of your master keyboard from being triggered twice 
by the same MIDI data. See the user manual of your keyboard for details on the Local settings.

The MIDI thru settings in energyXT include:

Off◊	 : Disables MIDI monitoring.

Auto◊	 : Enables MIDI monitoring anytime (Default setting).

Record◊	 : Enables MIDI monitoring only during recording.

Manual◊	 : Enables MIDI monitoring only if the monitoring for 
each track is activated in the track column.

To adjust the MIDI thru settings:

From the menu, choose i.	 Options > MIDI thru and select the 
appropriate setting.

In our example we chose the default setting 		 Auto.
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Configuring the metronome
If you want to record several instruments one after the other it is critical that you 
perform your music as exactly as possible to a given song tempo when recording. 
In energyXT you can use a metronome which, like its real counterpart, produces 
an audible click, the beat.

To set the tempo:

Input the song tempo in the field next to the transport controls.i.	

To configure the metronome:

Right-click on the metronome icon.i.	

Choose the number of beats per bar (1 to 8 beats). ii.	
E.g. 4 beats to count quarter notes for a 4/4 time signature.

Check the iii.	 Count-In entry if you want to have a one bar precount before the recording starts.

Check the iv.	 Playback and Recording entries if you want to hear the metronome's click during playback 
and recording.

Select a volume for the click under the v.	 Volume entry.

Check the vi.	 Enable entry to activate the metronome.
Alternatively, you can left-click the metronome symbol to enable / disable the metronome.

In our example we chose a song tempo of 100 bpm and enabled the metronome with a one bar precount to count quarter notes during 		
a recording.

Recording takes
Among musicians a recording is most commonly known as a take. A take can be just a few bars of length or 
even cover the whole song. For each take energyXT creates a Part from the beginning of the recording to 
its end. Parts can be modified later on in various ways as described in chapters "Editing Parts (Sequencer)" 
and "Working with patterns".

To record a take:

In the Sequencer view, select an Instrument Track for recording.i.	

Choose the correct MIDI channel at which the Instrument Track shall output MIDI data. For virtual ii.	
instruments you can also choose a preset sound.

Set a recording range in the bar line if you know the length of your musical performance.iii.	
Alternatively, you can set a zero range if you can't predict the length of your recording.

Place the song position pointer at the very beginning of the song or at the beginning of your record-iv.	
ing range.
Remember to use the grid function to place the song position pointer exactly at musical units (see chapter "The grid 
snap function (Sequencer)").
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Click on the Record button in the transport controls to start the recording.v.	
If you have activated the metronome's Count-In, the recording 
starts with the secondly counted bar.

Perform your music.vi.	
EnergyXT creates a Part for your recording.

Click on the Stop button in the transport controls to vii.	
stop the recording.
If you have predefined a record range, the Part length always matches the range. Otherwise, the Part ends as soon 
as you stop the recording.

In our example we recorded a 4 bar Lead take from the beginning of the song and another take on the Bass track of the same length. 		
Quantizing MIDI events
Once you have recorded a MIDI performance, the note events in the Sequencer exactly mirror your perfor-
mance with all timely looseness you may have performed with. It doesn't matter if you gave your best to 
play as accurately as possible to the click of the metronome, your timing will always be insufficient compared 
to the musical grid of the Sequencer. In some cases this variance in timing is volitional and is perceived as 
the human feel when you play back the music but in other cases (e.g. if you are not a good keyboard player 
or solely produce tightly timed electro music) these variances can lead to a very unstable and unsatisfying 
timing, especially when you play back several recorded tracks.

With energyXT, you can adjust your musical performance to a musical grid to make it more consistent. This 
function is called Quantization. When you quantize a performance each note is dragged to the nearest sur-
rounding matrix dot of the grid which corresponds to a selected note value. In most cases the note value 
for the quantization grid results from the shortest notes that your performance contains.

To quantize your recording:

In the Sequencer view, select the Part you wish to quantize.i.	

Choose a suitable note value for the quantization grid.ii.	

From the menu, choose iii.	 Part > Quantize.

After quantization you should play back your quantized Part and verify that the quantization was succes-
ful:

If the original rhythmical idea is preserved, the quantization was succesful. ◊	

If the original rhythmical idea has changed, you have to try a different setting for the quantization ◊	
grid.

If short notes appear displaced, you should try a smaller note value for the quantization setting.œœ
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Some performances can not be quantized with a single quantization setting properly. That's because they 
include too many diversified note values. In this case you need to apply different quantization values to 
individual passages.

To quantize individual passages:

In the Sequencer view, double-click on the track you wish to quantize to enter the edit view.i.	

Resize and zoom into the track to see all recorded notes.ii.	
You can scroll the view vertically when you place the mouse pointer on the claviature and turn the mouse wheel up 
and down. Alternatively, use the Page Up and Page Down keys.

Choose a suitable note value for the quantization grid.iii.	

Identify a group of notes which are close to the grid lines and select them.iv.	

From the menu, choose v.	 Part > Quantize.

Choose a suitable note value for the quantization grid that captures the remaining note values.vi.	
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Select the remaining notes that are close to the grid lines and select them.vii.	

From the menu, choose viii.	 Part > Quantize.

In our example we applied an eighth quantization to the Lead track Part, did the same with selected notes of the Bass track and quantized 		
the remaining notes of the Bass track Part to sixteenths.

Auto quantize

You may also use Auto quantize to quantize your performance automatically. 

In the Sequencer view, from the menu choose i.	 Options > Auto Quantize to enable / disable automatic 
quantization.

In most cases it is best to record the performance as is and do the quantization later on. Thereby œœ
you are able to try different settings or select the right quantization setting for each passage sepa-
rately. By Auto quantize activating, the original timing of your performance may be irretrievably 
distorted, depending on your quantization settings.

Shuffle quantize

You can use the quantize function intentionally wrong to change the rhythmic metrics of a binary to a 
ternary performance. You may do so to create the famous shuffle rhythms.

To add a shuffle quantization to a binary performance:

In the Sequencer view, double-click on the track you wish to quantize to enter the edit view.i.	

Resize and zoom into the track to see all recorded notes and select the notes you want to shuffle.ii.	
You can scroll the view vertically when you place the mouse pointer on the claviature and turn the mouse wheel up 
and down. Alternatively, use the Page Up and Page Down keys.
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Choose a quantization value and activate triplets.iii.	

From the menu, choose iv.	 Part > Quantize.
All notes will be dragged to triplet quantization values forming a shuffle rhythm.

In our example we applied an eighth triplet quantization to the Hihat track.		
Overdub recording
Overdubbing is a technique to add a musical performance to a previously recorded one. You can use this 
recording method to create harmonic lines without actually having to play the harmony at once. This is 
especially useful, if you are not so handy with playing the keyboard or you have a supplementary idea for 
a previously recorded take later on.

To perform an overdub recording:

In the Sequencer i.	
view, set a recording 
range.

Activate loop record-ii.	
ing.

Select a track and a iii.	
previously recorded 
Part for recording.

Start the recording iv.	
and perform your 
music.
You can add as many 
musical lines as you 
want with every loop 
cycle.

Stop the recording v.	
when you are finished.
The recorded layers are added to the existing Part. You may have to quantize the newly recorded notes.

In our example we recorded a harmonic layer to the Pad track.		
Punch recording
Instead of recording on top of a previously recorded take you can also exchange a small slice of a Part with 
a new take. You can use this method, for example, to exchange a bad take with a good one or to vary a take 
which is being repeated throughout your song to make it sound different with every repeat.

To perform a punch recording:

Set the grid snap function to i.	 Bar.

Place the song position pointer at the beginning of the slice you wish to re-record.ii.	

From the menu, choose iii.	 Part > Split to split the Part into two pieces.



54

MIDI Sequencer

Place the song position pointer at the end of the slice you wish to re-record.iv.	

From the menu, choose v.	 Part > Split to isolate the slice.

Select the isolated Part (Slice) and choose vi.	 Part > Delete to delete it.

Set the recording range in the bar line to the range of the now missing slice.vii.	

Place the song position pointer at the beginning of the recording range.viii.	

Redo the recording.ix.	
The newly created Part replaces the previous one. 

Select all Parts and from the menu choose x.	 Part > Glue to unite all Parts again.

In our example we substituted a slice of the Lead Part with a new recording.		
Working with patterns
EnergyXT displays recordings as 
Parts in a timeline. This concept 
facilitates a pattern oriented 
workflow as you can reuse mu-
sical phrases throughout the 
song. This is extremely useful 
if you have a traditional layout 
with verse and chorus. Even if 
you do not have a traditional 
song structure it is, at least, useful to use short phrases, riffs or elements again.

To create a reusable pattern:

Split your recorded takes to musically reasonable Parts (e.g. verse, chorus, riff, solo).i.	
Make use of the grid snap function to split Parts from bar to bar.

Select the Parts you wish to reuse.ii.	

To create a ghost copy:

Hold the iii.	 Ctrl key, grab the Parts with the mouse and drag them to a new position in the timeline.
The created pattern is a Ghost of the original pattern. That means if you change the contents of either the change 
will be made in both patterns.

To create an indepedent copy:

Select all Parts and from the menu, choose iv.	 Part > Un-ghost.
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Make use of all Part edit functions (e.g. Split, Glue, Copy, Move, Resize) to create reusable pat-œœ
terns.

In our example we created a ghost copy of all Parts from bars 1-5 and moved this pattern to bars 9-13.		
Editing MIDI events
An Instrument Track can host all types of MIDI events. A MIDI event results from either a recording or  
manually created entries. The most important events to trigger a tone generator (be it a virtual or an exter-
nal instrument) are the note events which determine the pitch, the position, the volume (velocity) and the 
length of a tone. Other standard events to shape the tone include Aftertouch, Program Change, PitchWheel, 
Modulation Wheel (CC1), Volume (CC7) and Expression (CC11). Moreover energyXT complies to all MIDI 
controllers of the MIDI standard.

In edit view, each Instrument Track by default displays the note events and 
the corresponding Velocity controller data. Additional controllers can be 
displayed by clicking on the + symbol in each Instrument Track and checking 
the type of controller from the drop-down list. Controllers that do not ap-
pear by name can be found under the entry Control Change. The list includes 
all CC controllers from 0-127. Refer to www.midi.org for a list of important 
controllers that transmit Control Change events. If the Instrument Track 
hosts a virtual instrument, the available control element destinations of the 
plug-in can be selected as well.

Recorded controller events will always be played back no matter if œœ
the events are being checked to be displayed or not.

Note event entries appear as horizontal bars with their length determining 
the note duration. Controller event entries appear as vertical bars with their 
maximum value at the top and their minimum at the bottom. For each con-
troller you can create entries manually with the mouse. See the paragraphs 
below for details.

Editing note events

In the edit view of a track, you can edit note events in the same way as Parts.

To edit note events:

Click a note event to select it.◊	

Click a note event and, with the mouse button depressed, drag it in any direction to change its posi-◊	
tion.
Remember to use the grid snap function to place note events at musical positions.

Use the mouse to grab the beginning or end of a note event to alter its length.◊	

Double-click to create a new note at the position of the mouse pointer.◊	

Right-click a note event to delete it.◊	

To identify the pitch of each note easily, it is useful to let the note names be displayed for each note event. 
Choose Options > Show note names from the menu to activate the feature. You can also use the claviature 
to the left for orientation. You can scroll the claviature up and down when you turn the mouse wheel while 
the mouse pointer hovers above it. Alternatively, use the Page Up and Page Down keys.

http://www.midi.org/about-midi/table3.shtml
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Note events are intrinsically tied to the Velocity controller which determines the volume of each note. You 
can alter each entry by clicking on the event and, with the mouse button depressed, drag it up and down. 
A new Velocity entry is created with every new note event.

Editing other controller data

All controller data appear as individual entries in the timeline. Unlike the Velocity controller they are not 
tied to note events. Due to a low zoom factor, very frequently recorded entries (e.g. ModWheel and Pitch-
Bend) may appear as a connected curve. You can edit both individual events and a group of events that 
form a curve.

To edit the value of individual events: 

Click on the event, and with the mouse button depressed, drag it up and down.i.	

To edit a group of subsequent entries that, due to their high density, appear as a curve:

With the mouse button depressed, draw a curve over all events.i.	
You may have to zoom in to access all events properly.

To create events manually do the following:

In the edit window, double-click at the time position where you want the event to be created.i.	
The exact position of the entry depends on the setting of the grid snap function and the actual zoom factor.
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Editing MIDI envelopes (energyXT2.5 only)

Instead of painfully placing and editing individual events to form a curve you can alternatively use MIDI 
envelopes to define a curve shape for a controller. With MIDI envelopes, it is easy to continuously change 
parameters over time. That's because they are created with only a few nodes which are automatically con-
nected and form a curve. A curve can be freely bend from linear to exponential. 

Reasonable standard MIDI events to control with MIDI envelopes include PitchWheel, ModWheel (CC1), 
Volume (CC7), Panorama (CC10) and Expression (CC11), plus any other controller that is being used to 
produce continuous parameter changes.

To create a MIDI envelope:

In the Sequencer view, set the grid snap function to i.	 4 to place nodes at quarter note values.
You may choose smaller note values to create more nodes for more detailed envelopes.

Check the controller entry (e.g. Expression CC11) to display the MIDI envelope edit window.ii.	

Add two envelope nodes by double-clicking into the edit window of the controller to create a fade in. iii.	
Place one node at the very beginning and the second a few quarters behind.
Envelope nodes are indicated by small squares and can be positioned horizontally and vertically by dragging them 
to the wanted position.
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Use the mouse to drag the first node to the bottom (minimum value) and the second to the top of the iv.	
edit window (maximum value).

Create another node at an intermediate value to slowly lower the Expression.v.	

To hold the reduced Expression level, create another node.vi.	

Add a final node at the end of your Part to create a fade out.vii.	
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Curve the fade in / out by dragging down the circle in between the nodes with the mouse to create viii.	
a smooth fade.

These are the basics on how to work with envelopes. From this example you may go ahead and create your 
own envelopes for various parameters (e.g. Pan, EQ, VST effect controls).

In our example we created a MIDI envelope for the Expression controller in the Lead track.		
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Remote controlling Instrument Tracks
Parameters of virtual instruments can be mapped to hardware controls of a MIDI controller unit or a master 
keyboard. Many virtual instruments already react on the basic MIDI controllers, e.g. ModWheel, PitchBend, 
Aftertouch and Expression, to name just a few. Refer to the user manual of your VST plug-in for details. Other 
parameters / controls can be freely mapped to react to specific MIDI controllers. You can also map a control 
of the virtual instrument's channel strip of the Mixer to a MIDI controller sent from a hardware unit.

A mapped MIDI controller can be recorded to an Instrument Track and edited just as explained in chapter 
"Editing MIDI events". 

If you do not own a MIDI controller unit, you can move the controls of energyXT's Mixer and virtual œœ
instruments with the mouse and record the movement.

To map the parameters of a virtual instrument to a MIDI controller unit:

Click on the MIDI indicator next to the metronome symbol to open the MIDI controller mapping i.	
dialog.

Click on the keyboard symbol to use the MIDI learn function.ii.	
EnergyXT now waits for a control element to be moved.

Make sure that the control you wish to control remotely is displayed on the screen. iii.	
To control a parameter of a VST instrument, you have to bring up its user interface.

Grab and drag the control element that you want to calibrate with the mouse (e.g. level fader, control iv.	
element of a VST instrument).
The Controller map dialog displays the parameter's name.

The parameters of energyXT's Synth / Sampler can only be automated from the plug-in's MIDI œœ
page.



61

MIDI Sequencer

Turn the control of your DAW controller up and down to map the control of your hardware to the v.	
control element of the software.

        

Repeat steps iv.-v. for every control you want to control remotely.vi.	

Click on the keyboard symbol in the Controller map dialog to finish the calibration.vii.	

Alter the values in the viii.	 Range fields to restrict the control range for a more precise input, if needed.

You can use the Controller map dialog in the same way if you want to assign hardware controls œœ
to the parameters of the instrument's Mixer channel.

In our example we mapped the volume fader of the instrument's Mixer channel to CC93 and the parameter LoFreq of the virtual instru-		
ment to CC74.

Using the Drum Track
EnergyXT features its own Drum Sampler, which is part of each Drum Track. The Drum Sampler can host 
several drum samples. Note events of the Drum Track appear in a special drum grid editor. Although the 
editor has a different look compared to the Instrument Track's editor, event editing is handled equally.

To create a Drum Track:

In the Sequencer view, from the menu choose i.	 Track > Add New > Drum Track.
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From the Browser window, select the name entry of a sample file and, with the mouse button depressed, ii.	
drag it onto the Drum Track.

Repeat step ii. for all samples you want to include in your Drum Track.iii.	

In the bar line, set a recording range in which you want to create a Drum Part.iv.	

Double-click into the Drum Track to create a drum Part.v.	

Set the grid snap function to the note value at which you wish to place the drum note events.vi.	

Double-click the drum Part to place a note event for each sample.vii.	
You can use the same edit functions for editing drum note events as for editing the note events of an Instrument 
Track. Refer to chapter "Editing note events" for details.
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Click on the triangle next to each drum sample's name to edit the volume (viii.	 Vol), panorama (Pan) or filter 
frequency (Cutoff) parameters for each note.
You can use the same edit functions for the parameters of the Drum Sampler as for the velocity controller of an Instru-
ment Track. See chapter "Editing note events" for details.

Alternatively, you can set the parameters in the Drum Sampler's user interface to fixed settings if they need not 
change with every note.

Instead of manually placing the drum note events you can also record the drums like any other œœ
Instrument Track. See chapter "Recording takes" for details.

In our example we created a basic drum Part with a bass drum, a snare drum and a hi-hat.		
From the user interface of the Drum Sampler, you can change the playback options for each sample sepa-
rately. To bring up the Drum sampler's user interface, click on any sample name in the track column.

The available parameters for each sample slot are as follows:

Volume◊	 : to change the volume.

Pan◊	 : to change the position in the stereo 
field.

Effects◊	 : to apply eq, insert and send effects to 
each drum slot (energyXT2.5 only).

Sample cell◊	 : to identify the key with which the 
sample is triggered from a keyboard.
The first drum sample is always mapped to C1. 
Other samples are mapped consecutively to the 
next half tone above.

Tuning◊	 : to alter the pitch.

Waveform view◊	 : to change the start and stop 
locators for the sample playback.
By default the sample is played back from begin-
ning to end. 

If you want to change the starting point, drag the 
S flagged locator with the mouse to the right. If 
you want to change the ending, drag the E flagged 
locator with the mouse to the left.

Use the buttons next to the program se-œœ
lector to activate / deactivate the different 
views (e.g. mixer, waveform)
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Using track Arpeggiator and Shuffle quantization

The Arpeggiator (energyXT2.5 only)

Each Instrument Track in energyXT2.5 features a powerful MIDI Arpeggiator which you can use to easily 
create a variety of different rhythmical patterns. With a monophonic input, the Arpeggiator simply repeats 
the played note and thus creates a rhythmical pattern. With a polyphonic input, the Arpeggiator can either 
do the same with all notes being played back as a chord or a sequence. The use of Arpeggiator patterns for 
bass lines, pads and lead voices is very popular in modern music production.

To activate the Arpeggiator:

In the Sequencer view select a track.i.	

Click on the power symbol.ii.	

Click on iii.	 e to bring up the user interface.

The Arpeggiator has nine different operation modes and several parameters to control the shape of the 
arpeggio patterns.

The operation modes are as follows:

Up◊	 , Down, Up-down, Up and down, Down-up, Down and up: 
to play back the notes in the selected order depending on 
their pitch.

As played◊	 : to play back the notes in the order in which the 
notes were played.

Chord◊	 : to play back the notes simultaneously.

Random◊	 : to play back the notes in random order.

Important parameters for the pattern control are as follows:

Step◊	 : to define a note value for the arpeggio pattern.

Gate◊	 : to set a value to cut the sustain of the notes.

Shuffle◊	 : to set a value for ternary pattern playback.

Rnd. velo◊	 : to randomize the velocity of the notes.

Oct◊	 : to spread the pattern over several octaves.

Additional controls are as follows:

Hold◊	  switch: to continue pattern playback even if the trigger notes are not held any longer.

3◊	 -switch: to switch the pattern from binary to ternary playback.

The Shuffle quantization

With the Shuffle quantization, you can force a track to be played back with the famous ternary shuffle feel. 
This option does basically the same as the Quantization function (see chapter "Shuffle quantize") when 
set to triplets, but with the advantage that it can be revoked any time, as the basic quantization remains  
unaffected by the Shuffle quantization. 
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To define a shuffle amount for an Instrument Track:

In the Sequencer view, select a track for shuffle quantization.i.	

Select a note value.ii.	

Adjust the amount of quantization.iii.	

Freezing tracks (energyXT2.5 only)
Tracks can be frozen to free up system resources. A frozen track will be played back like an Audio Track with 
all VST instruments disabled to save CPU power. As long as a track is frozen, it does not reflect any changes 
that you made unless you unfreeze it again. Use the freeze option if you encounter problems with your 
system performance.

To freeze an Instrument Track:

In the Sequencer view, select a track to freeze.i.	

From the menu, choose ii.	 Track > Freeze.
The track name shows frozen // to show the actual status of the track.

If you want to make changes to the track again:

From the menu, choose iii.	 Track > Freeze to unfreeze the track again.
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Target user: Guitarist / Keyboardist, Sound Designer
Due to the versatile concept of energyXT, it is possible to use the software also for building virtual effects 
racks. This application has become very popular over the last years for reproducing the sound of a guitar 
effects rack. With energyXT, you can use whatever VST effect you can buy or find in the net and create your 
very own personal effects rack. 

By chaining several effects, you can create a powerful multi-effect to substitute an expensive amp / stomp 
box hardware combination. You can play live with a guitar / keyboard amp but you can also record state-of-
the-art sounds into your computer. As a Sound Designer you may use this technique to create very complex 
new sound scapes with various input signals as well.

The setup
Basically, there are two different conceivable setups for live and studio use.

Guitarist / Keyboardist live setup

You need:

a 2-channel audio interface and an amplifier (or an amp head / cabinet combination)◊	

Electric Guitar

INPUT

LOUDSPEAKER

INSERT
SEND

INSERT
RETURN

MIDI Controller
(e.g. BEHRINGER FCB 1010)

Guitar Head (e.g. BEHRINGER GMX1200H)

MIDI OUT

MIDI IN

INPUT

Guitar Cabinet
(e.g. BUGERA 412H-BK)

MIDI IN

MIDI OUT

BAL/UNBAL
OUT

UNBAL
IN

FIREWIRE 1

FIREWIRE

USB

USB

Laptop

Audio Interface (e.g. BEHRINGER FCA202)

MIDI Interface
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Guitarist / Sound Designer studio setup

You need:

a 2-channel audio interface with microphone and guitar / line inputs◊	

or

a 2-channel audio interface with line inputs and a mixer◊	

Laptop

INPUTS

2-ch Audio Interface 
(with microphone and 

guitar / line inputs)

USB
LINE OUT

USB

Microphone 
(e.g. BEHRINGER B-2 PRO)

Electric Guitar

GUITAR IN 2MIC IN 1

Active Monitor Speakers
(e.g. BEHRINGER MS40)

Building a virtual FX rack step by step
The following section will show you how to configure energyXT as a virtual effects rack.

Before you follow the instructions below, make sure you've already set up your computer and œœ
energyXT properly. See chapter "Setup" for details.
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You will learn how to use virtual effects plug-ins (e.g. the built-in Guitar Amp), interconnect all plug-ins to 
build an effect chain and output or record the signal to an amp or Audio Track. Later on, you may take this 
demo Project as a starting point and tailor it to your needs. Keep track of the demo Project's progress by 
reading the text after each diary icon.

Creating a Project
Before you can make a recording you have to create a Project. 
The Project is the foundation for your song and contains all 
musical data, settings and parameters.

To create a Project:

Go to i.	 File > New Project.
Alternatively choose the respective template from the Welcome 
screen.

Choose ii.	 File > Save as... to call up the save dialog.

Choose a folder for your Projects.iii.	
The save dialog of energyXT is similar to that of the Windows 
Explorer user interface. The left column shows the folder tree of 
your drives and the right column lists all subfolders and energyXT 
related files that are present in the selected folder. The selected 
folder path is displayed at the top of the window.

Under iv.	 File:, enter a reasonable name for your Project.

Click v.	 OK, to save the Project.

In our example we created a new Project called 		 Virtual FX rack example and saved it to D:energyXT Projects.

Using the Modular view to build effect chains
The Modular view enables nearly unrestricted interconnection of Components, such as inputs, outputs, 
effects and instruments. This is where you can make the necessary connections for an effects chain. There 
are two ways of interconnecting effects:

Serial connection: the input signal consecutively travels from effect to effect. This creates a very powerful ◊	
effect, as the output of every effect plug-in is fed to the input of the next effect in the chain.

Parallel connection: the original input signal simultaneously travels through all effects. This signal path ◊	
gives more control over volume levels and effect details, as the original input signal is fed to the input 
of each effect and output levels can be controlled separately.

Of course, you can combine both connection types, if needed.
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To make the connections for a serial effects chain.

In the Modular view, select the name entry of a VST compatible effect or energyXT's Multi Effect from i.	
the Browser window and, with the mouse button depressed, drag it into the Modular view.
The plug-in will appear as a Component which is automatically connected to the Audio Out and the MIDI In Com-
ponents.

Repeat step i. for every effect you want to use.ii.	

Break the connection of the Audio In Component to the iii.	
Sequencer Component.
See chapter "Accessing Components in energyXT (Modular)" for details 
on how to make connections in the Modular view.

For every effect Component break the output connection to iv.	
the Audio Out Component.

Connect the Audio In Component to the input of the first v.	
effect. 

Connect the output of the first effect Component to the input vi.	
of the next effect.

Repeat step vi. for every effect Component.vii.	

Connect the output of the last effect Component to the input of the Audio Out Component.viii.	

Double-click on each effect Component to bring up its user interface and edit its parameters.ix.	

Use the dry / wet control of the applied effect to control the mix.œœ

In our example we created a serial effect chain with three VST effects.		
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To make the necessary connections for a parallel effects chain.

In the Modular view, select the name entry of a VST-compatible effect or energyXT's Multi Effect from i.	
the Browser window and, with the mouse button depressed, drag it into the Modular view.
The plug-in will appear as a Component which is automatically connected to the Audio Out and the MIDI In Com-
ponents.

Repeat step i. for every effect you want to use.ii.	

Break the connection of the Audio In Component iii.	
to the Sequencer Component.
See chapter "Accessing Components in energyXT 
(Modular)" for details on how to make connections in the 
Modular view.

Connect the Audio In Component to the input of iv.	
the first effect. 

Repeat step iv. for every effect Component.v.	

Double-click on each effect Component to bring vi.	
up its user interface and edit its parameters.

Use the dry / wet control of the applied effect to control the mix.œœ

You can individually adjust the level of each effect in the Mixer view by using the respective level œœ
faders.

In our example we created a parallel effect chain with three VST effects.		
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Setting the input signal level
Setting a proper signal level for the input signal is very important in order to avoid annoying 
artifacts.

If the level of the signal is

too high, the signal will distort.◊	

too low, the signal probably will be covered with noise and result in falsified sound.◊	

You can adjust the level of the input signal in the Mixer view. The Mixer is organized in channel 
strips. 

To set a proper input signal level, you need to be familiar with the following elements:

The Trim for boosting or lowering the input signal level at the top.◊	

The level fader with the corresponding level meter at the bottom.◊	

To adjust the level of the input signal properly:

In the Mixer view, identify the input channel strip to which your signal is connected(e.g. i.	 Audio 
In, [1+2] Audio In).

Play your instrument or whatever signal you have connected to your audio interface and ii.	
observe the level meter next to the level fader.

Adjust the level of the input signal at your audio interface according to the user manual of the unit, if iii.	
your audio interface includes a control for trimming the signal level.

Adjust the level of the input signal further with the Trim so that the peak amplitude of the signal barely iv.	
causes the level meter to reach the top.

Reduce the recording level with the level fader, if needed.v.	

In our example we adjusted the input signal level with the Trim to + 8.1 dB and left the level fader at its default 0.00 dB position.		
Effect racks (Guitar Amp)
Another way of building virtual effects chains is to use the built-in effect racks in energyXT, such as Guitar 
Amp. This virtual amplifier offers guitarists complete musical versatility to achieve the authentic sound and 
feel of a good analogue hardware amp - in software.

To insert a Guitar Amp track, proceed as follows:

Use the i.	 Quick add button and choose Guitar Amp.

Select a sound from ii.	 Clean to Dirty under Channel.

Adjust the parameters iii.	 Bass, Mid, Treble and Volume to tailor the 
sound to your needs.

Press the + button to add multiple effects to your rack (e.g. Bit iv.	
Crusher, Chorus or Compressor).
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Remote controlling effect parameters
Parameters of virtual effects can be freely mapped to hardware controls of a MIDI controller unit.

To map the parameters of a virtual instrument to a MIDI controller unit:

Click on the MIDI indicator next to the metronome symbol to open the MIDI controller mapping i.	
dialog.

Click on the keyboard symbol to use the MIDI learn function.ii.	
EnergyXT now waits for a control element to be moved.

Make sure that the user interface of the VST you wish to control remotely is displayed on the screen.iii.	

Grab and drag the control element that you want to calibrate with the mouse.iv.	
The Controller map dialog displays the parameter's name.

The parameters of energyXT's Multi Effect can only be automated from the plug-in's MIDI page.œœ

Turn the control of your MIDI controller up and down to map the control of your hardware to the control v.	
element of the software.
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Repeat steps iv.-v. for every control you want to control remotely.vi.	

Click on the keyboard symbol in the Controller map dialog to finish the calibration.vii.	

Alter the values in the viii.	 Range fields to restrict the control range for a more precise input, if needed.

In our example we mapped the parameters Chorus-Fine and Chorus-Rate of a chorus plug-in to controllers CC74 and CC71.		
Routing the input signal to an Audio Track
If you want to record the signal to an Audio Track you have to reconfigure the signal path in the Modular 
view.

To route a serial effect chain configuration to an Audio Track:

In the Modular view, break the output connection of the i.	
last effect Component in the chain to the Audio Out Com-
ponent.

Connect the output of the last effect Component in the chain ii.	
to the input of the Sequencer Component.
The basic Audio Track in the Sequencer view is now prepared to record 
the input signal.

See chapter "iii.	 Recording takes" for details on how to record 
Audio Tracks.

To route a parallel effect chain configuration to an Audio Track:

In the Modular view, break the output connec-i.	
tion of each effect Component to the Audio Out 
Component.

Connect the output of each effect Component to ii.	
the input of the Sequencer Component.
The basic Audio Track in the Sequencer view is now pre-
pared to record the input signal.

See chapter "iii.	 Recording takes" for details on how 
to record Audio Tracks.

In our example we routed the output of the last effect Component in the serial chain to the input of the Sequencer Component. For the 		
parallel configuration we routed the output of each effect Component in the chain to the Sequencer Component.
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Using energyXT on multiple systems
With energyXT you can work on different computers. For this purpose you should keep the application on 
a removable device (e.g. flash drive) together with all necessary files:

Keeping Project data together
If you want to transfer Projects to another computer, it's essential to keep the Project data and all embed-
ded audio files in a single location. Audio recordings will always be stored with your Project in a dedicated 
folder, though additional audio files (e.g. loops) remain in their source folders unless you save the Project 
with a new name. So it's a good idea to save your Projects by choosing File > Save as... to the media you use 
for transfer to ensure that all files are included.

Transfering data and restoring paths
Copy your Projects including the corresponding audio folders to the removable device.◊	

Transfer all VST plug-ins to the removable device.◊	

Many VST plug-ins require an installation in order to work on your system. These plug-ins rely on œœ
different system settings to be launched and won't work if you simply copy them with your VST 
plug-ins folder. Use freeware plug-ins instead that require no installation and no registration.

In energyXT, make sure that all path settings point to the correct location on the removable device, other-
wise plug-ins and audio data cannot be found. Check the settings under File > Setup > Browser before you 
try to open existing songs (see chapter "Setting folder paths"). Alternatively, you may open your song and 
tell energyXT the correct location of your files upon request.

Notice that even if you keep all data on a removable device it might be necessary to adjust path œœ
settings due to the fact that the drive letters might differ from computer to computer.

Switching between OSes
If you want to switch from one OS to another, e.g. from Windows to 
Linux, you should copy the two OS versions to different folders on a 
FAT32 formatted removable device (refer to the example picture). 

You then have to

activate one version, if not done already (see chapter "◊	 Activating 
your copy of energyXT" for details).

copy the file "XT.lck" from the root folder of the activated OS ◊	
version to the energyXT folder with the secondary OS' files so 
that both folders contain the activated key file.
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Glossary
ALSA

Advanced Linux Sound Architecture. A basic driver interface used in Linux operating systems for audio 
input and output.

ASIO

Audio Stream Input / Output. A professional driver interface which offers much better latency performance 
than DirectSound on Windows operating systems.

CDDA

Compact Disc Digital Audio, commonly known as (Sony / Philips) Audio CD.

Component

The Modular view of energyXT displays devices and channels as Components. There are two types of 
Components in energyXT: 

The input / output Components which represent physical hardware devices.◊	

The internal Components (Sequencer, VST effects / instruments) which represent software devices.◊	

Controller

Describes either a hardware controller which outputs MIDI data or a MIDI command to control param-
eters.

Core Audio

A professional driver interface used in Mac OS X operating systems for audio input and output.

DAW

Digital Audio Workstation. Synonym for a software that turns your computer into a complete audio record-
ing environment.

DirectSound

A basic driver interface used in Windows operating systems for audio input and output.

DVD-A

Digital Versatile Disc Audio. Multi-channel audio disc. Competitor to SACD.

Locator

Marker with which a playback / recording range can be defined.

Loop sample

A short pattern of a performance (e.g. guitar pattern, baseline, drum beat) with a length of usually 4-8 bars 
that most often comes as an audio file (e.g. WAV and AIFF) on a CD-ROM.

Master keyboard

A controller keyboard without tone generation.

Mixer

A mixer hosts all audio signals and grants access to individual signals.
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Modular

The term describes a system that can be freely configured and extended.

Pan / Panorama control

A control to position a signal in the stereo field. Defines the left / right alignment between the two loud-
speakers.

Part

An element in the Sequencer view with varying length that contains musical data (e.g. MIDI note events, 
audio)

SACD

Super Audio Compact Disc. Successor of the CDDA with multi-channel audio and higher quality.

Sampler

A device for recording sounds which can be triggered for playback via a keyboard or a MIDI sequencer.

Sequencer

A system that is capable of recording and playing back multiple audio and MIDI tracks.

Synthesizer

A device that generates sounds on a synthetic basis.

Tone generator

A device that outputs sounds either on a synthetic basis (synthesizer) or by playing back recorded sounds 
(sampler).

View

EnergyXT is organized in three different views: the Modular, the Mixer and the Sequencer view. 

VST instruments (virtual instruments) / VST effects

Software instruments and effects that support the popular VST standard for software plug-ins. A wealth of 
plug-ins can be downloaded from: www.kvraudio.com.

Support
If you have any problems with energyXT, check the online tutorials and the community pages on  
www.energy-xt.com or e-mail to support@energy-xt.com for help. Registered users may download the 
latest updates for free.

http://www.kvraudio.com
http://www.energy-xt.com
MAILTO:support@energy-xt.com
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